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1.2

Getting Started / Quick Start Guide

Below is a quick start guide to configuring Xrev Transmit for your first Sheet/Drawings Issue. There are
more advanced tasks you can complete with it which are outlined further in this document. But, the
below guide should give you enough information to install Xrev Transmit, sefup and do an issue with
your required settings fairly quickly.

1.
2.

Download Xrev Transmit from

Install the appropriate version you require (2011, 2012, ...). Note that you will require

Administrator privileges on your workstation fo install.

Follow the prompts and install the sub-components if prompted. Xrev Transmit requires .NET

4.0 (This will already be installed if running Revit 2012) and BioPDF (the PDF Printer Xrev

Transmit uses). If these are already installed the installation takes no longer than a minute

to complete on most workstations.

Xrev Transmit is now installed and ready to use.

Open the version of Revif you installed Xrev Transmit on, and open a project with a project

number entered. NOTE: Xrev Transmit will not be visible in the family environment; you must

have a project file open.

Click on the Add-Ins Tab and select Xrev Settings button.

MOELEIELCRCIFRY WORES Aol cicticavon
_ Home Insert Annotate Analyze Structure Massing &Site  Collaborate  View Manage = Add-Ins = Modify @~

% E‘- Revit I_.ookup
Modify| Issue Settings

Select Krev Revit Lookup

You should now see the General tab of the Settings dialogue as per below:

r |

M Settings - Xrev Transmit =NREl X

(0 Xrev

mmansmit

General &  Manage global settings.
Project
roie Issue Settings -
Farmats Allow 'on-the-fly' format customisation
Recipients Default Output Location: % UzerProfile%\Documents\rav Tranemifi<PrejMox\=Date=-<ProjStatus= | <= | | |

ClUsersicprice. CADWAY \Documentst¥rev Transmiti 1258400111053 1-PRELIMIMARY

Blank Sheet Scale Override: NTS

Issue Date Format: dihihAfyyyy = | |31/082011

Current Date Format: yyhhidd = | [1105831

Transmittal Document

| Template File: CA\ProgramData\Cadway'xrev 2011\Transmittal Template. docx | |

Maming Convention: <ProjNo=-Doc Trans-<Dates docx | = |

126640-DocTrans-110521.docx

OK Cancel



http://www.xrev.com.au/

This tab is used to manage seftings that will be used generally for all projects. The first item
to setup is the “Default Output Location”. This is the root directory of where you want files to
be oufput fo when doing your sheet/drawing issues. By clicking the Browse = button
you can navigate to the folder you wish the files to always go. However, you can be
clever about it! By clicking <> you can use parameter information from Revit and substitute
out folder names that match with Revit parameters. You can even have the formats
append to this output location to place different formats (DWG's, PDF’s) into their own
folders. For further information review the section.

Here is an example of a parametric output location:

YolzerProfile%et\Documents'xrey Transmiti=ProjMo=\=Date=-<ProjStatus= e

Chllsersicprice. CADWAY Documents rev Transmitt 125840011053 1-PRELIMIMARY

The next important section is the Transmittal File and the template it's using as well as the
naming convention required. By default the Template file is installed here:

Template File: C\PregramDatatCadway'rev 2011\ Transmittal Template.docx | |

Naming Gonvention: =ProjMo=-DocTrans-=Date= docx | == |

128540-DocTrans-1105821 docx
(a) C:\ProgramData\Cadway\Xrev (Windows 7), OR

(b) C:\Documents and Settings\ All Users\ Application Data\Cadway\ Xrev (Windows
XP)

. You can edit the template file using Microsoft Word 2007 or later. You can re-layout the

sections, reorder the columns and completely change all the fonts and styles in the
document to meet your office protocols. We suggest creating a copy first and editing the
copy in case you make a mistake. Please refer to section for
more information.

Next, set the Naming Convention. In the above example you can see that by using the <>
button you can add Revit and Windows parameters into the name to have it adjust
automatically for each project. You can also set the naming convention up to have a
complete file path or a relative file path to have it placed into a separate folder to the
default output location. Refer to for more information.

. The last critical area to setup is your format requirements and profiles. Select the Formats

tab in the left hand window.

You can see that it is possible to setup multiple profiles. These profiles are groups of output
formats. You may have a default Profile for the office, a default profile for particular clients
or even a default project just for specific projects depending on their exact requirements.
Select the "Default” Profile and choose “Modify”.

This opens a new window displaying the Profile Name and all the formats it includes.
Generally we suggest renaming the default profile fo be more specific to your company.
This way you know that you have customised it to suit your office standards. IE: In our case
it would be “Cadway Default”.
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16. You can Delete unwanted formats or Rename them to suit your office standards as
needed. As well as Add new formats using the Add... button.

-
& Modify Profile - Xrev Transmit

Profile name: | Default

Formats:

© oan DGN

© owr DWF - Combined
© owe DWG

° Hard Copy Mincha - A3
© ror PDF - A1

Q roF PDF - Al to A3

© ror PDF - A3

OK Cancel

If you click the orange bar on any of the formats they will expand to reveal the actual
settings for each format. Select the header again fo compress them.

-
A Medify Profile - Xrev Transmit

Profile name: | Default

Formats:

PDF PDF - AL

Printer:

| | PDF WWriter - bioPDF

Naming Convention:

=<ProjNo=-=SheetNo={=<Rev=]
125840-A1{-).pdf

] Combine selected views and
sheets into a single file

_ 1 Offset from corner:

Hidden Line Views:

(@) Vector Processing (Faster)
() Raster Processing

Appearance:

Raster Quality:

| Presentation -

Colors:

| calor -

Cpftions:

¥ Hide refiwork planes

v Hide unreferenced view tags
Replace halftone with thin lines
| Hide scope boxes

[V Hide crep boundaries
[V View links in blue

OK Cancel

18. The settings generally match those that are within the Revit Print and Export menus, with
the exception of the Naming Convention fields. Again by using the <> Drop Down menu
you can add parameters from Revif to format the actual naming of the files.




19. Here is an example of a PDF naming convention. In this case all the PDF's would get
placed in a PDF subfolder within the “Default Output Location”

Maming Convention:

FOF=ProjMo=-=SheetMo=(=Rev=).pdf ==
PDF25640-A1(-)pdf

|:| Combine selected views and sheets into a single file

20. Finish setting up all your formats to your requirements and then click OK to save them. Xrev
Transmit is now setup for you to issue sheets/drawings with!




1.3 Doing Your First Issue — A Step By Step Guide

Once you have configured the settings, all issues within Xrev Transmit are quick and easy. It's just a

maftter of following through the step by step wizard to have Xrev Transmit generate all the files you
want, along with the fransmittal if required.

1. To begin select the Add-Ins>Xrev->Issue Button

2. When you first run Xrev Transmit for a particular project there are only 2 Issue Mode options.
When running it subsequent times there will be a third option. This is used when sheets for a
project are spread amongst multiple Revit Files.

4 Issue - Xrev Transmit

q‘ Xﬁ!i‘.fu;.-m

Action

Please select an issue mode from the following options:

G New Issue with Transmittal

A new issue that includes a transmittal and is not linked to any previous issue.

Untracked Issue

An issue that does not include a transmittal

3. For this guide we will complete a New Issue with Transmittal. Select Next.




You are now on the Sheets section, you can edit any of the information displayed with the
exception of the Project Number and Scales within Revit and those changes will be
reflected on the sheets in Revit. Simply select the sheets you want to issue using the check
boxes at the left. You can select all using the pull down or select based on saved Sheet
Sets already created within Revit. It is also possible to rearrange columns, filter based on
rules, add/remove columns etc, but we'll just select the sheefts in this case and choose
Next.

# Issue - Xrev Transmit o |

‘!ﬁ Xrev

transmif
Sheets

Project Information:

Number: 125640 Address: | STREET, SUBURB,
BTATE, POSTCODE
Name: THE PROJECT
Client Name: | CLIENT Status: PRELIMINARY
Sheets to be issued:
Sheet Set: | <In-Session= - v
| ” Number | Revision |Name | Scale | Sheet Issue Date | Drawn By | Checked By | Approved By | Designed By |

Al Floor Plan  1:100 09/03/08 Author Checker Approver Designer
I A2 Sections  1:2, 1:10, 1:20,... 0%/03/08 Author Checker Approver Designer




“V Xrev

You are now on the Formats section. If you have “on-the-fly” editing enabled in the
seftings you can modify these formats here, otherwise these formats are read only. You
can also select different Profiles in order to select from different groups of format settings.

Use the tick boxes to select the formats you want to issue and then select Next.
[ 4 Issue - Xrev Transmit @Mw

“‘9 Xrev

tFansmil

Formats

Y- Toew Tooee T I
3

© owr DWF - Combined

© owe
-
© roF PDF - Al

O ror PDF - A1 0 A3

al © ror PDF - A3




6.

You are now on the Transmittal Secfion. Essentially you are filing out information now that
is only relevant to the generation of the Transmittal document. Select the Reason for Issue
from the drop down list and modify the Issued By person if needed.

M Issue - Xrev Transmit

‘!ﬁ'r Xrey

ransmit

Transmittal

Reason for lssue: | Appraise

|ssued By:

Distribution List:

lssue [ Name | Company Name Issue Methods DWWF | DWG | PDF | Size 4

Cancel




7. Foryour first issue on a particular project the Distribution List will be blank. Select the +
button to open the Add Recipients window. These Recipients are stored globally, so you
only have to create a person once and then you can add them to multiple projects. To
add arecipient select New then fill out the Recipients Name and their Company Name.
Repeat this process until all the Recipients you require are added. Then place a tick in
each of the checkboxes in the Add Column and select OK to add all those recipients to

this particular project.

. Add Recipients - Xrev Tm_ E@lﬂ

Jahn Farquiar

OOD0ONONOOEOOOoOOM

Search: | Names and Company Names__. b4 | Mew ‘ | Maodify ‘ | Delete |
Add || Mame Company Name
I Andre Venter Urban Art Projects -
Internal Internal
| John Beach Caltex Ausiralia Pefroleumn Pty Lid
Peter Cowden Caltex Australia Petroleumn Pty Ltd
Sean Foley Caltex Australia Petroleumn Pty Ltd
Allen London Caltex Australia Petroleumn Pty Ltd

Flanning Initiatives

Troy Piggins Lowenstein and Stumpo

Sal Kaluarachchi Lowenstein and Stumpo

David Brock Cushway Blackford and Associates

Simon Forster Cushway Blackford and Associates

Dean Bridge RPS Group

Jeremy Chan RPS Group

“ictor Cross Chilton Woodware and Associates

Magnus Clsen Beech Constructions -
OK Cancel
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8. By Default all these recipients will have the “Issue” box checked. If you've added people
that will not receive anything this issue, simply deselect them. For each recipient select the
Issue Method that the files will be delivered in and the formats they will be receiving. You
can select multiple formats.

¥ Issue - Xrev Transmit

@

£ N

o |

'I"ﬁgﬁmﬂf

Transmittal

Reason for lssue: [ Appraise

lssued By LA
Distribution List: B R
| Issue || Name a | Company Name | Issue Methods | DWF | DWG | PDF | Size
Andre Venter Urban Art Projects Email Al
David Brock Cushway Blackford and Associates Email Al
Dean Bridge RPS Group Disc = Al
3 Jonn Farguhar Planning Initiatives Email Al

Cancel

9. Select Next. NOTE: if you have not completed all the fields required for a recipient the
Next button will be greyed out.

10. This last page is a summary of everything that Xrev will be issuing and to whom. Essentially
a preview of the fransmittal infformation. Select Issue o start Xrev Transmit generating the
required files.




Rev: 1.2

11. This opens a Progress window to show exactly where Xrev fransmit is up fo. Unlike Revit this
window is always responsive when issuing. By clicking Close you can cancel at any time. If
for any reason any particular tasks fail (maybe because the network dropped out) you can
select the Repeat button to have the failed tasks attempted again — you can repeat all or

just the selected tasks.

o

/4 Issuing - Xrev Transmit

(‘ X;}%gf

sl

Details: 4 Filter = Repeat v
Task Status Message
Export sheet A1 - Floor Plan to PDF (POF - A1) SuCcess
Export sheet A2 - Sections to POF (POF - A1) Success
Export 2 sheets to DWF {DWF - Combined) Executing
Export sheet A1 - Floor Plan to DWG (DWG)
Export sheet A2 - Sections to WG (DWGE)
Generate transmittal document
Cancel




12. Navigate to your designated Output Location o see all the files that have been generated
to your standards!

Rev: 1.2

= B ) |
L arch 110531-PRE! IMINAR |
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| 't Favorites Documents library Ao ks ~
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. Project Docs Name .
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4 Downloads 125640-A1(-).dwg
l-'_ Recent Places 125640-A1(-).pdf
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= =S AT
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1.4 Pre-Requisites

Xrev Transmit requires the following to be installed:

Revit Architecture/MEP/Structure 2011/2012

.NET 4.0 Framework (installed by Xrev or Revit 2012)

BioPDF (Installed by Xrev)

e  Microsoft Office 2007 with the XPS add-in installed or Microsoft Office 2010

1.5 General Options
1.5.1 Issue Settings

This option enables or disables the ability fo modify the format settings during the issue process.
Deselect this option if you don't want users to make changes to these setftings.

The Default Output Location controls generally where you want your files to be exported to. However,
as you can add to this location using the Project overrides, or template naming convention, or format
naming conventions you can fechnically have all these 3 sections going to completely different
locations. The defaulf output location is generally an absolute location, for example:

P:\Projects\2011-012\Deliverables\Issued\ 110601

This isn't a very good example as it would require someone to modify the settings every time they
change projects or the date changes. A better approach would be to use the Parameter
placeholders. These can be accessed by clicking the <> button and selecting from the drop down list.
NOTE: The field gets added to wherever your cursor is currently within the fext field. For example:

P:\Projects\<ProjNo>\Deliverables\Issued\<Date>

In this section there are Parameter placeholders available from the Revit files Project Information
section as well as ones from the Windows session such as the Current Date, Computer Name and the
User Name.

You can also use windows explorer variables in this section as well as UNC paths. For example:
%UserProfile B\Documents\P<ProjNo>\Issued\<Date>-<ProjStatus>

equating to:
C:\Users\Chris\Documents\P2011-012\Issued\ 11060 1-PRELIMINARY

Or a UNC example:
\\server\Data\Projects\<ProjNo>\Deliverables\Issued\<Date>

These are useful when you can't guarantee all computers on the network have access to the same
mapped drives. The yellow box provides a preview of the output location based upon the information
in the current open Revit project.

If you just have 3D views or schedules placed on some of you sheets, your Revit title block scale will be
blank. Basically this allows you the ability to show a value on your Transmittal instead of it simply being
blank. Examples include: 1:1 or NTS

Rev: 1.2 15



The issue date format ensures that the sheet issue date parameter from Revit is of a standard format as
defined in this dialogue. You can simply select from the drop down list to get the format you require or
you can type your own.

Essentially:
y =Year
d =Day
M = Month
H =Hour
m = minute
s =second

You can delineate these values with any symbols or spaces as you like, and a multiple of each type
indicates how many characters you want to show (although 4 characters typically spells out the whole
word). Best to experiment or simply use the ones provided. The yellow box provides a preview of the
date.

The current date is a special field that Xrev Transmit generates based on the time the issue is
generated. Itis not connected to any Revit parameters and actually reads the date and time of your
computer. Formatting behaves exactly the same as the Issue Date Format.

1.5.2 Transmittal Document

This is the file that Xrev Transmit is using as a basis to generate the Transmittal document. By default this
file is installed here:

C:\Documents and Settings\All Users\Application Data\Cadway\Xrev (Windows XP), or
C:\ProgramData\Cadway\Xrev (Windows 7)

The template is by default Transmittal Template.docx(Microsoft Word 2007/2010). We suggest making a
copy of this file, placing it on a network location where all Xrev Transmit users can access it and
renaming it fo have a company prefix/descriptor. This file can be modified using Microsoft Word 2007
or later to suit your company standards. Please refer to the section for
further information on how to modify this document.

Once created, simply use the ... button to browse to the new template file.

NOTE: Currently this transmittal is "per issue only". That is, it does not accumulate issues into a single file.
Each issue generates its own fransmittal file.

All Naming Convention fields in Xrev Transmit can do two things, define the name of the file, but also set
the folder location for these particular documents. Using the <> button you can add Project
Information parameters from the Revit file as well as Microsoft Windows information displayed in the
drop down list. For example:

<ProjNo>-DocTrans-<Date>.docx

This would create a file called 2011-12-DocTrans-110601.docx located in the default output location. If
put all my document transmittals in a particular location | could do this:

Rev: 1.2 16



L:\Issue History\<ProjNo>\<ProjNo>-DocTrans-<Dafe>.docx

or if | want my transmittal in a particular sub-folder of the default output location
Transmittal\<ProjNo>-DocTrans-<Date>.docx

This would place the transmittal in a new subfolder called Transmittal which would be created in the
Default Output Location.

Using these few options nearly all folder structures should be able to be parametrically set so they work
for all projects without having to make changes to the settings each time.

1.5.3 Use Custom Revision Parameter

By default Xrev Transmit uses the in-built revisioning system of Revit. That is, it will use the "Current
Revision" parameter of each sheet to determine the revision number to use both in the file name and in
the transmittal. However, Xrev understands that for some the current revision tool is insufficient. As
such, we have allowed an override here to change what parameter gets mapped to the revision
placeholders.

Check this checkbox and enter the name of the parameter you are using on your fitleblocks fo
represent the revision. This will ensure the revision parameter you are using is correctly shown in file
names and on the fransmittal.

1.5.4 Define a Post Processing file to run

In order to allow maximum flexibility for advanced Xrev Transmit users, we have implemented an opftion
where you can run your own batch file (.bat), or executable (.exe) after Xrev Transmit has completed
ifs tasks. Simply browse for the file you wish fo run on the created files.

Examples of potential users include:

e A command that deletes the PCP files and/or image files generated by Revit for DWG files,

¢ A command that starts AutoCAD and runs a script on your DWG files o ensure they meet your
office AutoCAD requirements,

e A command that copies certain files into other locations, such as an FTP or Document
Management System.

Samples will be available from our website. Contact our support if you require assistance with creating
similar commands.

1.5.5 Methods of Issue

Here you can customise your methods for issuing drawings. This is used during the issue process when
defining how recipients will be sent drawings. You can add additional methods and their abbreviations
by selecting the New.. option. You can change them by selecting the item you wish fo change and
choosing modify, then making the change. Similarly if you wish to remove any, just select it and choose
Remove.

1.5.6 Reasons for Issue

Here you can customise the Reason for Issue drop down menu shown during the Issue process on the
Transmittal section. Simply select an item to Modify or Remove it using the buttons, or add new items by
selecting the New.. button and giving it a name.




1.6 Set up Formats / Profiles
1.6.1 Profiles

Profiles are basically grouped versions of your standard formats. You may have a company standard
profile, and/or you may have client specific profiles, and/or project specific profiles. You can access
the Profiles by opening the Xrev Transmit Settings command and going fo the Formats tab. If you select
a profile from the list you can see the buttons on the right of screen for New, Modify, Remove and
Duplicate enable.

¥ Settings - Xrev Transmit o | B |

eﬁ Xrev

transmil

General Manage format settings for printing and exporting shests.
Project Praofiles:
et Company Default | Mew . |
Recipients | |
Iodify ...
| Remove |
| Duplicate |
Ok Cancel

.

Selecting the New Option opens the “Add Profile” window. You must give the Profile a unique name
and then add your formats.

Selecting Modify opens the *Modify Profile” window. From here you can edit the Profile name and/or
edit/add/remove/rename formats contained within this profile.

Selecting Remove, deletes the selected Profile. We do not recommend deleting all the profiles.
Instead modify the default profile to suit your needs.

Selecting Duplicate, opens the Duplicate Profile window and prompts for a new name, it then creates
a copy of the selected profile with all the same formats settings which can then be modified
independently to the original profile. This is the recommended approach for creating additional client
or project specific profiles.

Rev: 1.2 18



1.6.2 Formats

Begin by modifying a Profile to open the "Modify Profile” window or create a New blank profile and
name if.

Select the Add... button to open the Add Format window. Give the format an appropriate and
descriptive name and select what Format Type you would like to create from the pull down menu.
There are options for DWG, DXF, DGN, DWF, PDF & Hard Copy. Hard Copy refers to network or local
printers and printing of physical pages.

-
% Add Format - Xrev Transmit . ﬁ
Mame: DWG - Company Export Layer5| I

Format type: | DWG -

Once clicking OK and confirming the creation of your format it is immediately added to the Formats List
in alphabetical order.

© owe DWG - Company Export Layers

You have two opftions at the right for renaming the format and deleting it. Selecting any of the formats
headers in this window expand them out to reveal their individual setfings. These can be customised fo
suit your company standards. You can have as many of each format as you like in a single profile.
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The below options are available in the DGN Format Settings:

Q© oan DGN

Naming Convention: Export Layers File: Template File:
=ProjNo=-=SheetNo=(<Rev=).dgn |«=}} . | I ' = \

10226-4-00(8).dgn

Naming Convention:

Here you can define the naming convention for the DGN files. Use the <> button to use revit
parameters in the naming convention. Refer to the section for additional
information on the various options available here.

Export Layers File (not available in Revit 2011):

Use the Browse button to specify the Export Layers File to be used for DGN exports or alternatively select
one of the standards from the drop down menu.

Template File:
Specify the DGN Template file (v7 only) to use for the DGN export. Note, as at Revit 2012, revit exports

v7 DGN files only. If you are using a later version of Microstation then use DWG.

The below opftions are available in the DWF Format Settings:

Q owr DWF - Combined ol I3

File Type: FPaper Size: Hidden Line Views:
) DWF @ DWFx | <Use Sheet Size= - @ “ector Processing (Faster)
() Raster Processing
Export Object Data: Orientation:
[+] Element properties ) Portrait (@ Landscape Appearance:
| Rooms and Areas in a separate .
boundary layer Raster Cluality:

Paper Placement: | Presentation -|
Graphics Setiings: @ Center Colars:
(@ Use standard format () Cfiset from cormer: (color -
() Use comprassed raster format

[omm !~ fTomm |
0 mm 0mm Optians:
Narming Convention: || Hide refiwork planes
<ProjNo>-m01(<Date>).dwt | - | Zoom: || Hide unreferenced view tags

o ["] Replace halftone with thin lines

10228-m01{11060:3).dwix () Fit to page
Combi ected vi g - Hide scope boxes
ombine selected views an . - i

@ Custom: 100 _ | % size ) )

¥ sheets into a single dwf file = [] Hide crop boundaries
File Type:

Define whether you'd like a DWF or DWFx

Export Object Data:

Element Properties — Specify whether properties from Revit Family Types and Instances are exported.
NOTE: Unpopulated fields are not exported, nor are custom Type parameters. Only custom Instance




parameters are exported from Revit as at Revit 2012. Also, object data is only exported from views with
the visual style set to Wireframe or Hidden Line.

Rooms and Areas in a separate boundary layer — select this option if you want room and area
properties separately from the geometric representation, so that individual rooms and room data can
be viewed with facility management software (such as Autodesk® FMDesktop), or DWF markup
software (such as Autodesk® Design Review)

Graphics Settings:
Use standard format — Select this option if you want to export images as PNG files.

Use compressed raster format — Select this opftion if you want to export images as compressed PNG files
and specify the quality required.

Naming Convention:

Specify the naming convention required for DWF files. Use revit and windows parameters in the file
name using the <> button. Refer fo the section for additional information.

Combine selected views and sheets into a single dwf file — select this option to have all the selected
sheets published to a single file. Naturally if you select this option you cannot use Revit sheet
parameters in the naming convention.

Paper Size:

Specify what sheet size you are using or select the <Use Sheet Size> option to have the export
automatically handle varying size sheets by reading the fitle block size.

Orientation:
Specify whether the sheet orientation is to be Portrait or Landscape.
Paper Placement:

Specify how the revit sheet is positioned on the sheet. Either offset from the corner a nominated
amount or placed centrally.

Zoom:
Specify the scaling factor required.
Hidden Line Views:

Select whether Hidden Line views are to be processed as images (Raster) or as lines (vector). Vector is
generally quicker and of higher quality, but occasionally some information may not be printed, in
which case raster settings may be required on that particular sheet.

Appearance:

Specify the quality required of images/renderings captured on the sheets and whether the sheets are
to be processed in Black and White, Greyscale or Colour.

Options:

Hide ref/work planes — Automatically turn off reference planes so they don't print/export

Hide unreferenced view tags — Automatically turn off any sections/elevations/callouts that have not
been placed on sheets yet.




Replace halffone with thin lines — Automatically use thin lines for halffoned elements instead of a grey
scaled line.

Hide scope boxes — Automatically turn off any visible scope boxes so they don't print/export

Hide crop boundaries — Automatically turn off any visible crop boundaries so they don't print/export

The below options are available in the DWG/DXF Format Settings:

©Q owe DWG ol IE3

Layers and Properties: Colors: Coordinate System Basis:

| All properties BYLAYER, New Layers ~| | Index Color (256 Colors) +| | Project Internal |
Export Layers File: Linetype Scaling: One DWG unit is:
RAD7. Settings\exportiayers-dw - | | | Scaled Linetype definitions +| | millimeter |
Naming Convention: File Version: [] Xref views on sheets

| AutoCAD 2007 v

=ProjNo=-=SheetNo=(<Rav=).dwg | <= ‘ [ ] Export rooms and areas as polylines

10225-A-00(B).dwg

Layers and Properties:

Select one of the following Export layer options to specify how Revit elements with view-specific
graphic overrides will be mapped to CAD layers. (Graphic properties of Revit elements, such as colour,
line weight, and line style, are defined in the Object Styles of the categories fo which the elements
belong, but these definitions can be overridden for a selected element in a specific view.)

Export category properties BYLAYER and overrides BYENTITY. A Revit element with view-specific graphic
overrides will retain those overrides in the CAD application, but will reside on the same CAD layer as
other entities in the same Revit category.

Export all properties BYLAYER, but do not export overrides. View-specific graphic overrides will be
ignored in the CAD application. Any exported Revit element will reside on the same CAD layer as other
entifies in the same Revit category. By forcing all entities to display the visual properties defined by their
layer, this option results in a lower number of layers and provides by-layer control over the exported
DWG/DWF file.

Export all properties BYLAYER, and create new layers for overrides. A Revit element with view-specific
graphics will be placed on its own CAD layer. This option provides by-layer control over the exported
DWG/DXF file, and preserves graphical intent. However, it increases the number of layers in the
exported DWG file.

Export Layers File (Not available in Revit 2011):

Specify the layer mapping file to be used, either by selecting one of the standards from the drop down
or using the browse button to select your own.

Colours:

On the Colours tab of the Modify DWG/DXF Export Setup dialog, select either of the following options to
specify how colours are exportfed to DWG or DXF files:

Index colour (255 Colours). For colours that are set by category, the indexed colours specified on the
Layers tab of the Modify DWG/DXF Export Setup dialog will be used. When colours are not set by
category and the override is preserved in the export, Revit uses the closest match from the 255 indexed
colours and thus may not provide an exact match for RGB and Pantone® colours.
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True colour (RGB Values). Uses the RGB value from Revit for the ByLayer and ByEntity parameters, rather
than the indexed colour from the Layers tab of the Modify DWG/DXF Export Setup dialog. For example,
when you export room (or space) colour fills, the colours in the exported file exactly match those in the
original file.

Linetype Scaling:

In AutoCAD, the PSLTSCALE parameter confrols paper space linetype scaling. A value of 0 indicates no
special linetype scaling. Linetype dash lengths are based on the drawing units of the space (model or
paper) in which the objects were created. A value of 1 indicates that viewport scaling governs linetype
scaling.

In Revit, the Linetype Scaling setting changes the default behaviour of the exported DWG files. Some
lines that you would expect to be dashed may now appear solid or in a different scale in either Model
or Sheeft View in AutoCAD. Regardless of the option you choose, the DWG linetype definitions are
created so that a dashed line always begins and ends with a dash.

You can select any of the following options to control the LTSCALE and PSLTSCALE setfings in AutoCAD
and to control how linetype definitions are exported from Revit:

Scaled Linetype definitions. This option preserves graphical intent by exporting linetypes the same as
they were previously scaled by view scale.

Modelspace (PSLTSCALE = 0). This option sets the LTSCALE parameter to view scale and the PSLTSCALE
fo 0.

Paperspace (PSLTSCALE = 1). This option sets the value of both LTSCALE and PSLTSCALE to 1. Revit
linetype definitions are scaled to reflect project units, but otherwise they are exported as is.

File Version:

Select what version of AutoCAD you wish to export the DWG/DXF to.

Coordinate System Basis:

Select where you want to export with the Project Internal coordinates or the shared coordinates.
One DWG unit is:

Specify the exported DWG/DXF unit system.

Xref views on sheet (Does not work in Revit 2011 and DWG only):

Specify whether each view on the sheet will be exported as an individual file and Xref'd to the sheet file
or as asingle file. NOTE: There are no naming confrols for the Xref'd views currently available in Xrev
Transmit.

Export rooms and areas as polylines:

Select the Export rooms and areas as polylines option if you want rooms and areas to be exported to a
DWG or DXF file as closed polylines.

Area polylines are generated from area plan views only.

Room polylines are generated from floor plan views or ceiling plan views only.




The below options are available in the PDF Format Settings:

Q roF PDF - Al &0
Printer: Faper Size: Hidden Line Views:
| PDF ‘writer - bioPDF - [A1 - @ Vector Processing (Faster)

" Raster Processing

Naming Convention: Crientation:
Appearance:

<ProjNo=-<SheetNo=(<Rev=)| | <= | ) Portrait (@) Landscape

Raster Cluality:

10225-A-00(B).pdf

Paver Pl N | Presentation -
[ Combine selected views and aper Flacement.
sheets into a single file @ Center Colars:
") Offsat from corner: Color -
— Options:
[0 mm omm |
|| Hide reffwark planes
|| Hide unreferenced view tags
. | | Replace halftone with thin lines
Zoom:
I [¥] Hide scope boxes
| Fit to page ) ]
— Hide crop boundaries
@ Custom: 100 _ | % size

[] Wiew links in blue

Printer:

Only PDF printers should show up on this list. However, although others will show up, Xrev Transmit
currently only supports automatic naming with the supplied bioPDF printer.

Naming Convention:

Specify the naming convention required for PDF files. Use Revit and windows parameters in the file
name using the <> butfon. Refer to the section for additional information.

Combine selected views and sheets info a single pdf file — select this option to have all the selected
sheets published to a single file. Naturally if you select this option you cannot use Revit sheet
parameters in the naming convention.

Paper Size:

Specify what sheet size you are using for this format.

Orientation:

Specify whether the sheet orientation is to be Portrait or Landscape.
Paper Placement:

Specify how the revit sheet is positioned on the sheet. Either offset from the corner a nominated
amount or placed centrally.

Zoom:

Specify the scaling factor required.
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Hidden Line Views:

Select whether Hidden Line views are to be processed as images (Raster) or as lines (vector). Vector is
generally quicker and of higher quality, but occasionally some information may not be printed, in
which case raster settings may be required on that particular sheet.

Appearance:

Specify the quality required of images/renderings captured on the sheets and whether the sheets are
to be processed in Black and White, Greyscale or Colour.

Options:
Hide ref/work planes — Automatically turn off reference planes so they don't print/export

Hide unreferenced view tags — Automatically furn off any sections/elevations/callouts that have not
been placed on sheets yet.

Replace halffone with thin lines — Automatically use thin lines for halffoned elements instead of a grey
scaled line.

Hide scope boxes — Automatically turn off any visible scope boxes so they don't print/export

Hide crop boundaries — Automatically furn off any visible crop boundaries so they don't print/export

The below options are available in the Hard Copy Format Setftings:

Printer: Paper Hidden Line Views:
| KOMICA MINOLTA C252 PS .| Size: @) Vector Processing (Faster)
| | Reverse print order A3 - | Raster Processing
[ Collate Source:
=(efault fray= - Appearance:
Orientation: . Raster Quality: .
i i Presentation -
_) Portrait @ Landscape
Colors:
Paper Placement: [ color |
@ Center
") Offset from cornar:
Options:
omm] v [Gmm ] || Hide reffwork planes
|v| Hide unreferenced view tags
) [] Replace halftone with thin lines
Zoom:
o || Hide scope boxes
| Fit to page ) )
- || Hide crop boundaries
@ Customn: 100 _ | % size

|| View links in blue

Printer:

Specify your Local or Network Printer you wish to use (use common sense and don't select a local
printer if using in a network deployment). Select whether to use reverse print order or collate on your
hard copies.

Rev: 1.2 25



Paper:

Specify the paper size being used and the paper tray source.
Orientation:

Specify whether the sheet orientation is to be Portrait or Landscape.
Paper Placement:

Specify how the revit sheet is positioned on the sheet. Either offset from the corner a nominated
amount or placed centrally.

Zoom:
Specify the scaling factor required.
Hidden Line Views:

Select whether Hidden Line views are to be processed as images (Raster) or as lines (vector). Vectoris
generally quicker and of higher quality, but occasionally some information may not be printed, in
which case raster settings may be required on that particular sheet.

Appearance:

Specify the quality required of images/renderings captured on the sheets and whether the sheets are
to be processed in Black and White, Greyscale or Colour.

Options:
Hide ref/work planes — Automatically turn off reference planes so they don't print/export

Hide unreferenced view tags — Automatically furn off any sections/elevations/callouts that have not
been placed on sheets yet.

Replace halffone with thin lines — Automatically use thin lines for halffoned elements instead of a grey
scaled line.

Hide scope boxes — Automatically turn off any visible scope boxes so they don’t print/export

Hide crop boundaries — Automatically turn off any visible crop boundaries so they don't print/export
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1.7 Output Locations

This section outlines how to use the various Output locations options in the Xrev Transmit settings.

1.7.1 Browse to a Folder

The most obvious way to set your output location is to use the folder button and browse to the specific
folder that you want the files to be saved. However, there are much better ways to set output
locations in Xrev Transmit than using the browse button. The issue with this option is for each new
project you more than likely need to reset the oufput location each time.

1.7.2 Using Revit Parameters

You can use the Browse to a folder opftion initially but then we suggest modifying project specific folder
structures by swapping out Revit parameter tokens which can be placed using the <> button. This
essentially means that these parts will parametrically update based upon the setftings in the Revit file,
eliminating the need to edit the Output Locations each time. Basically you can set once and forget
about them provided you have a standard folder structure.

Valid tokens currently are either of the Project Information category or Sheet category:
Default Output Location, Project Output Location, Transmittal Naming Convention:

<ProjName> - Revit Project Name

<ProjNo> - Revit Project Number

<ProjStatus> - Revit Project Status

<ProjlssueDate> - Revit Project Issue Date

<Date> - Current Date from the System

<ComputerName> - Computer Name from the System

<UserName> - User Name from the System

+ Any custom project information category parameters you have added, just select from the
pull down tag list...
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=

Project
Sheet

Current Date
Computer Name

User Mame

There are additional Parameters available for the individual Format Naming Conventions as these

gather sheet parameters as well:

<SheetName> - Revit Sheet Name

<SheetNo> - Revit Sheet Number

Sheet Mame

Sheet Number
Approved By
Checked By
Revision
Revision Date
Designed By
Drawn By

Sheet Issue Date

Current Revisicn

Current Revisicn Description
Current Revision Issued By
Current Revision Issued To
Dependency

Discipline

File Path

Order

Referencing Detail

Referencing Sheet

<ApprovedBy> - Revit Sheet Approved By

<CheckedBy> - Revit Sheet Checked By

<Rev> - Revit Sheet Current Revision

<RevDate> - Revit Sheet Current Revision Date

<DesignedBy> - Revit Sheet Designed By

<DrawnBy> - Revit Sheet Drawn By

<SheetlssueDate> - Revit Sheet Issue Date

+ Any custom sheet category parameters you have added, just select from the pull down tag

list...

All of these tokens can be used to define both file names as well as folder names or parts of folder

names. For example say you have a folder structure as follows:

P:\0001254\Outgoing\Architectural

This could be rewritten as (where 1254 is the Project Number in Revit):

P:\000<ProjNo>\Outgoing\Architectural




1.7.3 Absolute Paths

An absolute path is a folder path that is complete on its own. For instance, a mapped drive location or
a UNC folder path... You can actually place an absolute path in any of the following sections. This
doesn’'t mean you should, it's just that technically it's supported:

e Global Default Output Location

e Transmittal Naming Convention

e Project Output Location (Override)

e All Format Naming Conventions (DWG, PDF, DWF, DXF, DGN)

So what does that mean?2 Basically by placing a full file path for one of the naming conventions it
overrides the Global Default Output Location and/or the Project Output Location.

1.7.4 Accumulative Paths

An accumulative folder path is only part of the folder structure and it is combined with other sections in
order to create the full file path. The Global Default Output Location must be an absolute path.

For Example:
Global Default Output Location = C:\My Projects\<ProjNo>
Transmittal Naming Convention = Issued\Transmittals\<ProjNo>-DocTrans-<Date>

Accumulates to give C:\ My Projects\ <ProjNo>\Issued\Transmittals\ <ProjNo>-DocTrans-<Date>.docx
as my effective output location for my fransmittals. This modularisation means that all output locations
can be achieved in a parametric fashion.

1.7.5 Outputting Specific Formats to Individual Folders

By inputting folder names intfo the naming convention fields for each format type it is possible to output
these formats to their own individual folders.

For Example:
Global Default Output Location = C:\My Projects\<ProjNo>\Issued\<Date>-
<ProjStatus>
Al PDF Format Naming Convention = PDF\<ProjNo>-<SheetNo>(<Rev>).pdf

Accumulates to give:

C:\My Projects\<ProjNo>\Issued\<Date>-<ProjStatus>\ PDF\<ProjNo>-<SheetNo>(<Rev>).pdf
With the fields substituted with the Revit Project Parameter values:

C:\My Projects\2011_106\Issued\110616-TENDER\ PDF\2011_106-A205(3).pdf

Similarly, if you want a PDF set to go in a completely different location, for instance a copy to an FTP site
you can use absolute paths.

For Example:

Global Default Output Location = C:\My Projects\<ProjNo>\Issued\<Date>-
<ProjStatus>
Al PDF Format Naming Convention = F:\<ProjNo>\<Date>\<ProjNo>-

<SheetNo>(<Rev>).pdf

In this case, the PDF location overrides the global default output location and as such it is ignored.
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1.7.6 Microsoft Windows Variables

Xrev supports using Microsoft Windows environment variables in your naming conventions and oufput
locations as well.

For Example:

e %ALLUSERSPROFILE%
e  Z%LOCALAPPDATA%
e  %APPDATA%

e %PROGRAMFILES%

e  %PROGRAMDATA%
e  %SYSTEMDRIVE%

e %USERNAMEZ%

e %USERPROFILE%

1.8 Naming Conventions

The Naming Conventions in Xrev Transmit will also define the Output Locations. Basically the tokens and
text after the last backslash indicate will define the file name. Please refer to the

section for examples of Naming Conventions and valid Revit Parameter tokens. Correct use of these
will ensure you can set and forget all the settings in Xrev Transmit.




1.9 Customising the Transmittal

Xrev Transmit uses a Microsoft Word 2007/2010 template file for generating the transmittal document.
An example fransmittal is supplied as part of the installation of which you are welcome to customise as
you need to match your own company standards. However, we suggest making a copy just in case
you make a mistake. This sample document can be found here, and if doing a network deployment
should be moved to a central location:

C:\ProgramData\ Cadway\ Xrev\Transmittal Template.docx (Windows 7 & Vista)
C:\Documents and Settings\ All Users\ Application Data\Cadway\Xrev (Windows XP)

NOTE: Xrev Transmit does not support Microsoft Word 2003. Xrev Transmit cannot do historical
fransmittals, each fransmittal is a one off and can only include information regarding a single issue at
this stage.

1.9.1 Editing the Transmittal in Word

Please make a copy of the Transmittal before making any edits,

1. Open the Transmittal Template.docx file in Microsoft Word 2007 or later.

2. By default the Transmittal consists of 4 fables and a header/footer.

3. You may edit the header/footer as you require using standard features. There is nothing
particularly special about this. So swap out images, or remove them all together and standard
word field codes for document numbering etc. Or leave the header and footer blank if you
like.

4. The trickier bits and the parts that Xrev Transmit is interested in are contained within the tables.

5. This word document has been setup using Word Styles, Color Themes and Fontfs Themes. As
such you can very quickly make modifications to suit your standards by changing the Themes
to matfch your own office standards.

6. Go to the Layout tab, and the Themes panel.

7. Use the Colors pull down to edit the colour themes.

8. Use the Fonts pull down to edit the fonts used for Headings and Body text.

9. Now that you have set the Fonts and Colours fo suit your needs you can begin modifying the
table styles.

10. The Project Information table and Transmittal Information table don't actually need to exist. All
the "“Plain Text Content Conftrols” used here can exist outside of the table if you prefer.

11. The Distribution List fable and Documentation List tables must remain in tables as this is crifical to
how Xrev Transmit generates all the exira rows. These tables must always be laid out so only
one Recipient occupies each row and only one sheet occupies each row.

12. That said you can re-order the columns as you see fit and remove tags/columns that you do
not require.

13. The “Plain Text Content Controls” can be copied around or you can place new ones from
scratch — however only ones supplied within the sample document are supported. To place
new controls you must enable the Developer tab in word. This is done through
File>Options>Customise Ribbon and then checking Developer in the right hand pane (Word
2010).

14. With the developer tab enabled if you select one of the confrols you can open the Properties
of one of these controls. The most important part for Xrev Transmit fo successfully substitute
these fields is the “Tag” field must match what we supply. If this doesn’t match exactly the field
will not be substituted.

15. To edit the table styles enable the Styles window and choose Modify Styles,

16. The Project Information and Transmittal Information tables use the Cadway Table style, so
modify the settings of this table as needed fo suit your requirements.

17. The Distribution List and Documentation List tables use Cadway Table 2 style, so similar modify
its settings as needed to suit your requirements. These tables are set to repeat the header row
when spanning multiple pages.
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18. Or course all other text, headings etc. can be changed as you require and additional
disclaimers added as you see fit.

19. Hopefully thisis enough information to get you started, if you aren’t that familiar with Microsoft
Word then there are some greaf resources on the internet. But failing this please don’t hesitate
to contact our support team and see if they can assist reproducing your requirement.




1.10 Updating Xrev Transmit

Updating Xrev Transmit when a new version comes out couldn’t be simpler. Simply download the
installer from the website (the trial and full version installer are the exact same file). Run the installer with
Administrator privileges, follow the prompts and your Xrev Transmit will be updated to the current
version in a matter of seconds.

If you experience any issues updating Xrev Transmit please don't hesitate to contact our support team.

1.11 Deploying a Network Setup

Currently deploying Xrev Transmit to have shared settings throughout an office is somewhat manual. It
is relatively simple and quick to do, but may put some less technical people out of their comfort zone.
We plan to have a more user friendly solution developed soon!

1.11.1 Sharing your Settings

All Xrev Transmit Settings are stored in the Transmit.sdf compact database file. By default this file is
installed here:

C:\ProgramData\ Cadway\ Xrev\Transmit.sdf (Windows 7 & Vista)
C:\Documents and Settings\ All Users\ Application Data\Cadway\Xrev (Windows XP)
To share your setfings:

1. Close down all instances of Autodesk Revit,

Navigate to this file and copy it fo a network location that all computers can access and have

full read/write permissions to access.

Navigate to: C:\Program Files\Cadway\Xrev

Copy the XrevTransmit.exe.config file fo the same network location.

Open this file by double clicking on it or simply open it in Notepad.

Find the line that says:
a. DataFilePath="C:\ProgramData\Cadway\Xrev\Transmit.sdf" OR
b. DataFilePath=" C:\Documents and Settings\ All Users\ Application

Data\Cadway\Xrev\Transmit.sdf"”

7. Replace the bit in between the quotation marks with the new network location where you
copied the database to.

8. Save and close the file.

9. Copy this config file back to C:\Program Files\Cadway\Xrev\XrevTransmit.exe.config and
overwrite the original. NOTE: You may require Administrator privileges to do this.

10. For all additional installs, before starting Revit or Xrev, just copy this file and overwrite the
existing one on each workstation (Repeat Step 9).

N

oW

1.11.2 Quickly Copy Setftings to Multiple Computers

You can very easily create a batch file that copies this file for you, to save time navigating around the
folders. This way it should only take a few seconds to update each workstation that Xrev Transmit is
installed on.

1. To do this create a new text file and change the file extension from .ixt fo .bat,

2. Right Click and Edif the batch file,

3. Add the following strings, but substitute the part in RED with your actual file location.
a. xcopy /y "“\\server\Xrev Settings\Xreviransmit.exe.config” “C:\Program

Files\Cadway\"

b. Pause

4. Save the file.

You will still need Administrator privileges to run this batch file though.

6. Run the batch file on each machine by double clicking it.

o
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1.12 Issue Types

There are 3 different types of issues you can do with Xrev Transmit.

1.12.1 New Issue with Transmittal

This issue method is probably the one you'll use the most. Use this method if you want if to issue your
Revit Sheets to formats and create a new fransmittal document to accompany the issue.

1.12.2 Append to Existing Issue (working with linked files)

This issue method has been created when you have Revit Sheets for a single project spread amongst
multiple project files. Using this method you can combine all those Sheets to be issued on to a single
fransmittal. This method is unavailable until you have done a New Issue with Transmittal for this
particular project number. To use this option:

Create a New Issue with Transmittal in one of the project files,

1.

2. Select the Sheets you want to issue,

3. Select the Formats you want to issue,

4. Select the Recipients/Issue Methods etc,

5. Complete the issue,

6. Open the next file for this project containing additional sheets you want fo issue,

7. Select the Issue button on the Add-ins tab of Revit in Xrev Transmit to open up the Issue dialog,

8. Provided this project has the same "“Project Number” you will have a new option displaying
“Append to Existing Issue”

9. Select this option, now simply select the additional sheets to add to the issue,

10. There is no need to select formats or recipients as the settings from the first step will be used.

11. Select Issue, these files are created and these items added to the Transmiftal.

12. Repeat Steps 7-11 for each Revit file until you have all your documents created and included
on the transmittal.

1.12.3 Untracked Issue

This method is used when you don't want a transmittal and you just want to print/export sheets from
Revit. As such using this method you don't have the Transmittal tab as part of the wizard.




1.13 Project Overrides

Sometimes you may have a particular project that may need to use different settings than your office
stfandard. In the Settings dialog, this is the purpose of the Project tab.

If values are set here they override the equivalent seftings on the General tab.

1.13.1 Settings stored by Project Number

It is important to note that settings made on the Project tab are only applicable to the Project Number
of the Revit file you currently have open. If you open another project with a different Project Number in
Revit then these settings will be blank again.

This is as infended, as these settings should only really need to be used under special circumstances.

1.13.2 Project Output Location

Enter your Output Location here to either override the global output location or append fo it. This is
useful if you have a project using a different folder structure to your current standard, or other special
circumstance when files need to be ordered differently...

1.13.3 Project Default Profile

For each project you can set the default format profile to use. This way as a Revit Manager, you can
ensure your team is using the correct PDF, DWG, DWF etc settings for this partficular project. Again this
sefting is stored by Project Number.

1.13.4 Custom Revision Parameter

For this project, define whether to use the option defined in the general settings, you can override and
set a different revision parameter to use, or you can choose to use the standard revision parameter.
1.13.5 Post Processing

In this section you have 3 options. You can choose to use the post processing option defined in the
general seftings, you can override and set a different post processing file, or you can disable post
processing on this particular project all together. Please refer to the General Settings, post processing
feature for further information on this opftion.
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1.14 Managing Recipients

Settings can be added/edited/deleted either directly during the Issue process or through the Settings
window. You can access the Recipients list by going fo the Add-ins tab and clicking on the Settings
button in the Xrev Transmit panel.

1.14.1 Adding Recipients to a Project

When doing an Issue, on the Transmittal tab, in the Distribution List there is a large + button. Select this
to open the Add Recipient window.

' Add Recipients - Xrev Transmit | [EENEERTC

Search: X | New |
Add || MName Company Name
[T Andre Venter Urban Art Projects -
[]  Internal Internal

|| [7]  John Beach Caltex Australia Petroleum Pty Ltd

[]  Peter Cowden Caltex Australia Petroleum Pty Ltd
|:| Sean Foley Caltex Ausiralia Peiroleum Pty Lid
[]  Allen London Caltex Australia Petroleum Pty Ltd =
[]  John Farguhar Planning Initiatives
[T]  Troy Piggins Lowenstein and Stumpo
[[]  &al Kaluarachchi Lowenstein and Stumpo

L4 |:|J David Brock Cushway Blackford and Associates
|:| Simon Forster Cushway Blackford and Associates
[]  Dean Bridge RPS Group
[]  Jeremy Chan RPS Group
[]  wictor Cross Chilton Woodware and Associates
[]  Magnus Olsen Beech Constructions -

oK Cancel

You can type in the field to automatically start filtering the list to display only information relevant, or
you can sort the columns as needed. If you hold down ‘shift” and click on multiple column headers it is
possible to sort by multiple columns, for instance by Company Name and then by Name. You can
even group contacts by their company by right clicking on the Column Header and choosing “Group
By This Column”.

Click on the Tick box for “Add"” next to each recipient you'd like to add to the project. Once added
these recipients will always be available for this project.

1.14.2 Adding Recipients to the database

It is possible to add new recipients to the database on the fly during the Issue process or through
settings.

1. With the Add Recipients window open, choose New

2. Enter the Recipients Name and Company Name (You can select from the drop down list to
ensure consistency)

3. Select OK

4. The Recipient has now been added.

1. Open the Seftings command and go fo the recipients tab.

2. Choose New

3. Enfer the Recipients Name and Company Name (You can select from the drop down list to
ensure consistency)
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Select OK
The Recipient has now been added.

Modifying/Deleting Recipients

Similar fo the Adding process, simply select a recipient in the window and choose Modify or
Delete,

Modify opens the Modify Recipient window so you can make changes,

Delete removes the Recipient permanently from the database (all projects).

To remove a Recipient just from a project, during the Issue Process on the Transmittal tab,
Select the Recipient from the list,

Press the Orange X to remove them.




1.15 Revit Revision Tool

Xrev Transmit is meant to be used with the standard Revit revision tool. Rather than enforce
complicated workarounds that could potentially be rendered useless when/if Autodesk add a fix for
any limitations, we have designed the tool to compliment Revit within those constraints.

As such, Xrev Transmit will not automatically auto-increment revisions simply because we believed this
approach does not represent a good workflow. Typically when adding new revisions to sheets you
should either be clouding the specific changes and tagging them, or checking a specific milestone
issue to show on the sheet through the sheet instance properties. Either of these two parts are not
currently accessible through the Revit API.

1.15.1 Revit Limitations

Currently the Revit revision sequencing is limited fo alphabetic or numeric. Therefore alphanumeric
numbering sequences such as P1, P2, P3 or C1, C2, C3 are not achievable without workarounds.

Known workarounds include:

e Using the Issued By field and mapping your revision sequence tfo this. Using this method you
won't be able to get auto-incrementing of revisions or do sheet specific number sequencing.

e Add a prefix to the Revision label in the titleblock and then use the standard number sequence
from Revit. With this method the revision schedule is unable to show the prefix.

e Use a custom "text" shared parameter added to the sheet category. Using this method you
won't get automated incrementing or be able to use the automated Revit Revision Schedules.

Hopefully in a future release Autodesk add capabilities for more custom number sequences or make
the sequencing accessible through the Revit API.

Another limitation is the lack of ability to have a revision schedule be broken into multiple parts like all
other Revit Schedules. As such you are limited fo one revision schedule with a single group of rows.

1.15.2 Adding Revisions

As mentioned previously Xrev Transmit does not automatically add Revisions to your sheets, once your
sheets are setup and ready to issue you then run the Xrev Transmit Issue command.

Before you can add a Revision you must create a Revision to add:

e Inthe View ftab, under Sheet Composition, Select Revisions.

Sheet Issues/Revisions @I_Z—h]
Sequenc| Murmbering Description Issued Issued to | Issued by Add ]
Alphabeti 10.10.2009 | PRELIMIMARY ISS CLIENT CLP Cloud and Numbering
Alphabeti 01.02.2010 | DA ISSUE [ CLIENT CLP Cloud and ©) Per Project
(@) Per Sheet
Fow
’ Move Down l
’ Merge Down l
Alphabetic Sequence
’ Options... l
[ oK ] [ Cancel ] App
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e Sefyour numbering method to be either Per Sheet or Per Project
o PerSheet - Each Revision Counting is individually counted per sheet, so the first revision
on that sheet will always be 1 or A
o PerProject - The Revision count is global, so it is possible for the first revision of a sheet
tobe 3 or D.

e You can edit the Alphabetic sequence to add/remove letters from the sequence that may be
confusing. Forinstance | or O.

e Select Add to add a new row fo the list.

e Setthe numbering method to be used and fill out the various methods.

e You have now created a new revision that can be applied to sheets/clouds. Note the
Sequence number of this revision and it is always good practice to sef the previous revision to
be "Issued" using the check box so no more clouds can accidentally be added to that
sequence.

There are two ways to add a revision to a sheet:

e To show a particular Revision on a sheet first select that sheet or open it to show its instance
properties.

e Inthe Identity Data section there is a parameter called "Revisions on Sheet", select the Edit...
button next to this to open up the Revisions on Sheet window.

e Add a check to which Revisions you need to show on this sheet.

NOTE: Some rows may be checked and greyed out, this indicates that a revision cloud has been
placed on this sheet associated to that particular revision. Therefore, if you want to remove that
particular revision from the Revision Schedule you would need to remove the Revision cloud associated
with it on this sheet.

e Affer you have created a Revision fo add, go fo the view or sheet that you would like to cloud.

e Go to the Annotate tab, Detail panel and select Revision Cloud.

e Inthe Instance Properties of the sketch mode ensure the Revision is set to the correct sequence
number you added earlier.

e Skefch your revision cloud.

e Choose the Green Tick to finish sketch.

e Use Tag by Category fo tag your Cloud if necessary.

1.15.3 Setting up you Title Block to use the automated Revit Revisioning System

To use the Revit Revisioning tool as opposed to using a manual system you generally want to include
two parts. A label that shows the current Revision, and a schedule to display or historical issues of this
sheet.

1. Open/Edit your titleblock family or begin a new family.

2. If you don't already have a Revision Schedule in your Project Browser, add one by going to the
View tab, Create panel and choose Revision Schedule.

3. Add the required fields you need to display, but ensure you include the "Revision Sequence”
and sort by this, as this will ensure you schedule correctly sorts when using both alphabetic and
numeric numbering sequences.

4. Format the Schedule using standard scheduling tools to have it appear how you like.

5. Hide the Revision Sequence column by right clicking on it and choosing Hide.

6. Place the Revision Schedule on the sheet by dragging it from the Project Browser into the view.

7. Go to the Home tab, Text panel and choose label and place it somewhere.

8. Add the "Current Revision" parameter to the Label Parameter List

9

1

. Choose OK
0. You have now setup your titleblock to correctly use the Revit Revisioning System.




1.16 Troubleshooting

Please report any errors/problems you have to our support team at support@xrev.com.au and we will
address it as a priority.

1.16.1 Transmittal Save As PDF Fails

Revit 2011 & Revit 2012, with Microsoft Office 2007

When Issuing the step for Transmittal generation it reports an error:

“Error converting fransmittal document fo PDF”

Xrev Transmit requires the Save As PDF / XPS add-in to be installed on Microsoft Office 2007. If this is not
installed Xrev Transmit will still create the Word Document, but it will not create the accompanying PDF
file.

Please download and install the “Save as PDF add-in for MS Office” (Free). This can be downloaded
here:

1.16.2 Print Generation Fails (Hard Copy/PDF)

Revit 2011 & Revit 2012, with Hard Copy Printers using older printer drivers

When attempting fo do an Issue or run Xrev Transmit you receive an error when Printing fo any printer.

When you run Xrev Transmit, it checks your system through the Revit API to identify what Printers are
available and what their capabilities are. Occasionally this process comes across a particular printer
that causes it to fail; this could be through a poor quality or old printer driver. Unfortunately once this
printer causes the Revit API prinfer command to fail; it enters an error state and can only be restored by
shutting down Revit and restarting it.

We have been unable to identify a workaround for this internal Revit APlissue. As such, we ask that our
users systematically (temporarily) remove printers one at a fime and try Xrev Transmit unfil you identify
which printer is causing the failure. With the particular printer identified, please check to see if there are
updated or different drivers available and try those. If the printer isn't critical, then the removal of the
printer from the workstation will ensure Xrev Transmit functions correctly. We have filed this issue with
Autodesk and hope to have a better solution for the next version of Revit.

1.16.3 Activation Fails

Revit 2011 & Revit 2012, with locked down networks through Firewalls / Proxy Servers

When attempting fo activate Xrev Transmit the activation fails.

To activate Xrev Transmit needs to contact our License server over HTTP. If this is filtered or blocked your
computer may not be able to access this server.



http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=7

You can try temporarily removing the Proxy setting in Internet Explorer to bypass the proxy server and try
activation as this may resolve the issue or add license.xrev.com.au to your whitelist. Alternatively there
is a manual activation process in the Licensing part of Xrev Transmit which requires you to manually
send us the Machine code (that Xrev Transmit generates) and the serial number. We will then supply
an activation code for each machine that is unable fo activate.
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